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        Digitizer  EX
                 «Программа для создания вышивок»
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1. ВВЕДЕНИЕ
Данный курс обучения был разработан с тем, чтобы снять ореол таинственности с удивительного мира цифрового преобразования данных. Благодаря этому курсу, вы постепенно научитесь использовать самые важные инструменты.
В данном руководстве рассматриваются различные приложения и возможности, такие как:
· Click-to-Design, которое немедленно преобразует рисунок в цифровой форме в программу вышивки на вышивальной машине
· Ручная оцифровка, применяемая теми, кто хочет полностью контролировать все аспекты композиции
· Шрифтовое оформление, для которого имеются 56 встроенных шрифтов и различных форм
Вы потренируетесь в выполнении упражнений, специально разработанных для вас и позволяющих вам повышать уровень ваших знаний.
	Упражнение
	Цель
	Инструменты

	4.1
Фигуры
	Изучение различий между этими инструментами.
	· Щелчок правой кнопкой, щелчок левой кнопкой
· Parallel Fill (Параллельный застил), Turning Angle Fill (Угловой застил), Single Run Line (Контурная линия)

	4.2
Волнистая линия
	Как изменить, добавить, удалять точки инструмен​том Reshape (Изменить фигуру).
	· Parallel Fill (Параллельный застил)
· Reshape (Изменить фигуру)

	4.3
Круг
	Как формировать изобра​жение инструментом Par​allel Fill (Параллельный застил) и затем коррек​тировать его инструмен​тами Embossed Fill (Рельеф) и Motif Fill (Ап​пликация).
	· Вставка круга с параллельным застилом Parallel Weave Fill: Circle (Параллельный застил: Круг)
· Parallel Fill (Параллельный застил)
· Visualizer (Режим отображения)
· Embossed Fill (Рельеф), Motif Fill (Аппликация)
· Изменение цветов

	4.4
Эмблема
	Изменение формы инст​рументом Reshape (Из​менить фигуру), исполь​зование инструмента Border (Обвод контура бордюром), цен​тровка двух объектов.
	· Вставка прямоугольника с параллельным застилом  Parallel Weave Fill: Rectangle  (Параллельный застил: Прямоугольник)
· Reshape (Изменить фигуру)
· Border (Обвод контура бордюром )
· Центровка и масштабирование рисунка
· Медленное прорисовывание

	5
Шрифтовое оформление
	Как использовать инст​румент Шрифтовое оформление (основы)
	· Шрифты, Размер знака
· Ориентация
· Изменение формы знака

	6
Автоматиче​ская оцифровка
	Использование инстру​мента Автоматическая оцифровка.
	· Автоматическая оцифровка

· Изменение цвета по таблице 

	
	
	· 


2. ОСНОВНЫЕ ВОЗМОЖНОСТИ
Мы с гордостью представляем наше новое программное обеспечение – «Digitizer EX», программу, которая была разработана для реализации всех возможностей наших компьютиризированных швейно-вышивальных машин. По мере работы с этой программой вы откроете для себя все ее преимущества, включая высоко-качественное автоматическое форматирование в вышивальный формат графи-ческих изображений. И не важно, что является источником вашего вдохновения (выполненный вручную рисунок, клип, отсканированные изображения, рисунки из Интернета, рисунки с дискет) – результат Вас обязательно устроит. После завершения подготовки рисунка подключите компьютер к вышивальной машине (если соединительный кабель входит в комплект машины) или скопируйте его на USB флеш-память или на карту Compact Flash.
	Создание оригинальных рисунков
	Вы можете создавать полностью оригинальные рисунки для вышивки: в графических редакторах; сканировать любые рисунки; загружать клипы или фотографии с цифровых фотокамер.

Даже если качество изображения далеко от идеального, вы можете создать эскиз изображения автоматическим способом и затем улучшить изображение инструментальными средствами обработки изображений. 

	Форматирование графических изобра-жений - перевод рисунка из графического формата в вышивальный, т.е. в формат «понятный» швейной машине
	В данной программе имеются возможности форматирования, рисунков в автома-тическом, полуавтоматическом и ручном режиме, чтобы пользователи, не имеющие опыта работы с графическими изображениями, могли постепенно научиться этому. Опытные пользователи могут вносить в рисунки любые изменения.

	Форматирование фотографий с помо-щью программы Photo Click
	С помощью новой программы Photo Click можно легко создавать вышивки фотографических изображений. Итак, если вы используете цифровые фотокамеры  или отсканируете обычные фотографии, вы сможете эти фотографии и вышить.

	Высококачественные текстуры
	Добавление к вышивке текстуры значительно улучшает ее внешний вид.

В программе Digitizer Ex имеется выбор из более, чем 130 комбинаций стежков. Кроме того, в программе имеется библиотека готовых фрагментов для создания изысканных, филигранных стилей.

	Текст и монограммы
	Добавление текста или монограммы в ваш проект позволяет создать оригинальную вышивку, в том числе для подарка. Текст можно поворачивать в различных направлениях, растягивать, наклонять или изгибать. Кроме того, в программе имеется большой выбор готовых бордюров для окончательного оформления изображения. У вас есть возможность выбора более чем из 50 предварительно отформатированных шрифтов, но Вы можете  создавать и дополнительные, используя шрифты TrueType, установленные на Вашем компьютере.

	Шрифты TrueType™ для вышивания гладью
	Вы можете использовать для вышивки любой шрифт TrueType™, установленный на вашем компьютере. Вы можете менять их по собственному желанию, а также копировать любые шрифты, которые используются в логотипах коммерческих товаров.

	Расширенное редактирование
	С помощью программы EasyEdit, входящей в Digitizer Ex можно точно отлаживать вышивку рисунков вплоть до отдельного стежка. Благодаря неограниченным возможностям редактирования,  можно выполнять вышивки превосходного качества.

	Высококачественные контуры
	Вы можете выполнять контуры вышивки стежками стачивающей строчкой, челночными стежками для вышивания гладью, а кружевными узорами обеспечивать отличное обрамление краев вышивки или добавлять к ней дополнительные декоративные детали. Вы можете полностью контролировать длину, ширину стежка и плотность строчки.

	Изменение размеров рисунков
	Вы можете изменять размеры рисунков, сохраняя, при этом изначальную плотность строчек. Программа автоматически регулирует количество стежков и положение ткани так, что изменённый рисунок выглядит не хуже оригинала. Для изменения размеров, с целью обеспечения соответствия выбранным пяльцам или задуманному проекту, вы можете преобразовывать изображения во всех основных форматах.

	Зеркальное отражение и поворот рисунков
	Для обеспечения точного положения рисунка в проекте, изображение можно поворачивать с шагом в один градус.

Можно также располагать стежки под определенным углом на рисунке для придания ему рельефности и объёмности. Можно копировать рисунки и зеркально отражать или использовать функции копирования (copy) и вставки (paste) для создания больших вышивок.

Вы без труда можете создать серию одинаковых рисунков с одинаковым оформлением по углам и границам.

	Прекрасные цвета
	Создавайте реалистичные изображения природных объектов, таких как цветы и животные, с помощью комбинирования стежков и затенения. Таким способом можно получить цвета любой насыщенности, а функция сглаживания краев поможет Вам достичь естественно выглядящих эффектов и создать впечатление ручной вышивки.

	Коллекции рисунков

Используемые форматы
Сохранение созданных дизайнов вышивки
	В Digitizer Ex имеется коллекция рисунков, в которую можно добавлять созданные Вами  изображения, и в которой их можно легко просматривать, а также извлекать. Все Ваши работы можно хранить и записывать в одну основную библиотеку. Вы также можете выбирать вышивки с CD-дисков или Карт Compact Flash (РС-карт), их можно прообразовывать из одного формата в другой, как по отдельности, так и группами.
Digitizer Ex поддерживает все основные форматы, используемые в бытовых вышивальных машинах различных марок: *.JEF, *.JAN, *.JMT, *.SEW, *.CSD, *.DST, *.EMD, *.EXP, *.HUS, *.PCM, *.PCS, *.PEC, *.PES, *.VIP, *.VP3, *.XXX.
Чтобы сохранить разработанный дизайн вышивки для последующей вышивки на швейной машине, его можно записать на Флеш-память USB или на Карту Compact Flash (РС-карту), предварительно создав там папку Embf.

	
	


3. ОСНОВНЫЕ ФУНКЦИИ
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3.1 
Запуск программы Digitizer Ex
Выполните двойной щелчок левой клавишей мыши по пиктограмме EasyDesign программы Digitizer Ex на рабочем столе компьютера.
Для открытия программы EasyDesign потребуется некоторое время, продолжительность которого зависит от мощности вашего компьютера. После запуска программы перед вами откроется окно начала работы Getting Started. Существуют 3 возможности выбора:
· Open An Existing Design (Открыть имеющийся дизайн вышивки):
Используйте данную опцию, если у вас есть готовые дизайны вышивки (для машин Janome и New Home это формат *.JAN).
· Digitize An Existing Image (Форматировать имеющийся рисунок):
Используйте данную опцию, если у вас имеется графическое изображение в цифровом формате, которое Вы хотите форматировать в вышивальный формат и вышить.
· Free-hand Digitize (Создание рисунка от руки):
Используйте данную опцию, если вы хотите создать новый дизайн вышивки с помощью инструментов, имеющихся в программе Digitizer Ex.
При выборе опции Digitize An Existing Image (Форматировать имеющийся рисунок) или Free-hand Digitize (Создание рисунка от руки) открывается окно Choose Fabric (Выбрать ткань). С помощью ползунка на линейке с правой стороны окна выберите одну из множества имеющихся в списке тканей.
После выбора нужной ткани в окне Required Stabilizer: (Требуемый стабилизатор) выводится рекомендация об используемом стабилизаторе.

[image: image3.emf]
[image: image4.emf]

[image: image5.emf]
[image: image6.emf]
[image: image7.emf]

Комплекс Digitizer Ex состоит из двух программ: EasyDesign (Лёгкий дизайн) и  EasyEdit (Лёгкое редактирование).
Запуск программы EasyEdit
Выполните двойной щелчок левой клавишей мыши по пиктограмме EasyEdit программы на рабочем столе компьютера.
Вы можете настроить вид окна рисунка, отобразив или скрыв сетку, изменив размеры сетки и набор инструментов.
Переключение между EasyDesign и EasyEdit
Комплекс Digitizer Ex позволяет вам быстро и легко переключаться между окнами EasyDesign и EasyEdit с помощью пиктограммы на панели инструментов.
· Это пиктограмма переключения в EasyDesign, находящаяся в верхней части панели инструментов окна EasyEdit.
· Это пиктограмма переключения в EasyEdit, находящаяся в верхней части панели инструментов окна EasyDesign.
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Открытие рисунков в EasyDesign:

Выполните щелчок левой клавишей мыши по пиктограмме Open (Открыть). По умолчанию выводятся файлы с расширением рисунков для вышивки, таким как *.JAN. Тем не менее, в строке Files of Type (Типы файлов) можно выбрать другие форматы файлов с готовыми вышивками, например, *.JEF, *.SEW и т.д., выбирая опцию All Files (Все файлы). После установки курсора на имя файла в окне выводится предварительный просмотр рисунка, включая такую информацию о нем, как количество стежков, количество цветов и размеры рисунка.

В программе EasyDesign можно открыть любые оцифрованные рисунки следующих графических форматов: *.BMP, *.JPG, *.PNG, *.PSX, *.WMF, *.EMF, *.EPS, но сделать это можно только через команду основного меню: Image>Insert Image (Объект>Вставка Объекта), при этом происходит предварительная обработка загружаемого файла программой Digitizer Ex.
Использование команд
Если вы не уверены в том, какую пиктограмму следует использовать, просто наведите курсор мыши на нее, после чего будет выведено ее имя.
[image: image1.jpg]


Для запуска команд достаточно одного щелчка кнопкой мыши по пиктограмме. В левом нижнем углу некоторых пиктограмм имеется стрелка. Достаточно щелкнуть левой кнопкой мыши по стрелке, и на экране отобразятся вложенные пиктограммы.
Панели инструментов Digitizer Ex являются плавающими. Для перемещения панели инструментов в нужное место просто щелкните по ней левой кнопкой мыши и, удерживая ее, перетащите панель. Для возврата плавающей панели инструментов в стандартное положение выполните двойной щелчок левой кнопкой мыши по строке заголовка голубого цвета.
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3.2 
Создание новых рисунков
При запуске Digitizer Ex автоматически создается новый файл «Design 1» (Рисунок 1). По умолчанию для файла «Design 1» используется стандартный шаблон «NORMAL». В шаблонах данного вида содержатся предварительные установки, стили и стандартные объекты, облегчающие работу в швейных форматах.

Создание рисунков, основанных на шаблоне «Normal»:
Выполнить щелчок левой кнопкой мыши по пиктограмме New (Новый). Открывается окно с пустым рисунком.
Установка опций сетки:

Для точного выравнивания или изменения размеров объектов вышивки можно использовать линии сетки. Сетку можно включать и отключать, а также изменять ее размеры в зависимости от потребностей.

Отображение и скрытие сетки
Самый быстрый для этого способ – выполнить щелчок левой кнопкой мыши по пиктограмме Grid (Сетка) на панели инструментов View (Вид).

Можно также выбрать команды View>Grid (Вид>Сетка). Если строка Grid (Сетка) отмечена, то сетка будет отображаться на экране. Если нет, то линии сетки будут скрыты.
Еще одним способом включения линий сетки является щелчок правой кнопкой мыши по пустой части экрана. При этом появляется всплывающее меню.
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Установка шага сетки:

У вас есть возможность установить шаг сетки в диапазоне от 2 мм до 20 мм. По умолчанию шаг сетки равен 10 мм.

Выберите Setup>Work Environment (Установка > Рабочая среда). С помощью ползунка на шкале выставьте шаг сетки. Значение шага сетки будет указываться над ползунком.
Работа с пяльцами:

В окнах Digitizer Ex визуально отображается графическое изображение пяльцев, которое помогает устанавливать размеры и располагать рисунки в пределах пяльцев. Граница строчки в пяльцах изображается тонкой красной линией. Если какая-либо часть рисунка выходит за пределы границ строчки, при сохранении рисунка вы получите сообщение об этом.
Отображение пяльцев:

Самый быстрый для этого способ – выполнить щелчок левой кнопкой мыши по пиктограмме Hoop (Пяльцы) на панели инструментов View (Вид).
Можно также выбрать команды View>Hoop (Вид>Пяльцы). Если строка Hoop (Пяльцы) отмечена, то пяльцы отображаются на экране. Если нет, то пяльцы скрыты.
Еще одним способом включения отображения пяльцев является щелчок правой кнопкой мыши по пустой части экрана. При этом появляется всплывающее меню.
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Центровка пяльцев:

Функция Automatic Centering (Автоматическая центровка) обеспечивает автоматическую установку центра пяльцев в центре открытого рисунка или в точке (0,0) окна открытого рисунка, в котором ещё нет стежков.

Выберите Setup>Work Environment (Установка > Рабочая среда). Если требуется подключить функцию автоматической центровки, щелчком левой кнопкой мыши поставьте отметку в клетке Automatic Centering.
Измерение расстояния на экране:

Данная функция позволяет измерять расстояние между двумя точками на экране. Расстояние указывается в миллиметрах или дюймах в зависимости от региональных установок, выбранных вами в Панели управления Windows.
Выберите View>Measuring Tape (Вид>Мерная лента). Выполните щелчок левой кнопкой мыши в начальной точке и переместите курсор мыши в конечную точку. Курсор примет вид мерной ленты, и на экране будет указана длина линии и угол ее наклона.
Отключение функции выполняется кнопкой сброса Esc.

Можно также определить ширину и высоту рисунка по размерам, показанным в строке состояния в нижнем левом углу экрана.
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3.3 
Сохранение рисунков:

Программа Digitizer Ex позволяет сохранять рисунки в собственном формате *.JAN, а также в других форматах файлов вышивки, используемых в бытовых вышивальных машинах различных марок: *.JEF, *.JAN, *.JMT, *.SEW, *.CSD, *.DST, *.EMD, *.EXP, *.HUS, *.PCM, *.PCS, *.PEC, *.PES, *.VIP, *.VP3, *.XXX.
Сохранение  рисунка в процессе работы:

При сохранении рисунков в компьютере выполняется запись имени файла, его расположения, формата и сохранения любых производимых вами изменений. 
Выполните щелчок левой кнопкой мыши по пиктограмме Save (Сохранить). Если сохранение выполняется в первый раз, используйте окно Save As (Сохранить как).
Выберите формат, в котором нужно сохранить рисунок. Чтобы сохранить разработанный дизайн вышивки для последующей вышивки на швейной машине, его можно записать на Флеш-память USB или на Карту Compact Flash (РС-карту), предварительно создав там папку Embf.
Настройка опций автоматического сохранения:

Для защиты от потери информации при сбоях оборудования или программного обеспечения, используйте функцию Auto Save (Автоматическое сохранение), обеспечивающую сохранение вашей работы в автоматическом режиме через равные интервалы времени.

Выберите Setup>Work Environment (Установка > Рабочая среда). Затем вкладку Autosave (Автоматическое сохранение). Убедитесь в том, что клетка Auto Save Design Every (Автоматически сохранять каждый рисунок) отмечена. После этого можно установить периодичность сохранения рисунка в минутах.

Автоматически сохраненные копии файлов будут храниться в папке «BACKUP» с расширением ВАК.
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4. БАЗОВЫЕ УПРАЖНЕНИЯ:

Эти простые упражнения были разработаны для того, чтобы научить вас использовать правую и левую кнопки мыши с  инструментами, расположенными справа на панели инструментов EasyDesign:
	[image: image24.emf]
	Операция  Parallel Fill (Параллельный застил) -  для вставки фигур, заполненных параллельными стежками.

	[image: image25.emf]
	Операция Turning Angle Fill (Угловой застил) - для создания колонок различной ширины при обеспечении плавного поворота строчек на соответствующий угол.

	[image: image26.emf]
	Операция Single Run Line (Контурная линия) для разме-щения последовательности стежков по намеченному контуру фигуры. 
Кроме этих трёх команд, там же размещены пиктограммы следующих операций: Parallel Weave Fill: Rectangle  (Параллельный застил: Прямоугольник), Parallel Weave Fill: Circle (Параллельный застил: Круг), Border (Обвод контура бордюром).


1. Выполнение упражнений с фигурами
                  Откройте программу EasyDesign .
	1. [image: image27.png]



	2. Выполните щелчок левой кнопкой мыши по пиктограмме New (Новый) для создания  нового изображения.

	
	3. Используя вышеперечисленные инструменты, постройте фигуры изображённые на рисунке справа.

4.  Главное: между двумя кликами левой клавишей мыши программа проводит прямую линию, по трём кликам правой клавишей – окружность. 

	
	5. Если справа нет таблицы: объект, тип объекта, тип строчки, кол-во стежков, - выполните щелчок левой кнопкой мыши по пиктограмме Resequence (Упорядочение).
6. Выбрав Single Run Line (Контурная линия) и Parallel Fill (Параллельный застил) с помощью левой кнопки мыши постройте фигуры с прямыми линиями (две первые в примере). 
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	7. Щелчком по пиктограмме Visualizer (Отображение) можно переключать просмотр с обычного режима на режим объемного отображения и наоборот.

	
	8. Для вставки рисунка Крест нажмите Ctrl и выполните щелчки левой кнопкой мыши для получения строго прямых линий. Закончив фигуру, нажмите на клавишу Enter.

	
	9. Теперь с помощью правой кнопки мыши вставим овал. Подтвердим вставку клавишей Enter.

	
	10. Следующая фигура – круг. Его вставка производится командой Parallel Weave Fill: Circle (Вставка круглых фигур с параллельным застилом).

	[image: image31.png]el




	11. Следующий шаг – вставка трех линий с помощью инструмента Single Run Line (Контурная линия). При этом, волнистая линия (пятая фигура) создаётся следующим образом: щелчок правой клавишей в трёх точках, левой – в третьей точке, правой – в четвёртой и пятой, левой – в пятой и т.д.  
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	12. Следующие три фигуры вставим с помощью инструмента Parallel Fill (Параллельный застил).
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	13. Вставка последней фигуры производится с помощью инструмента Turning Angle Fill (Угловой застил). Введите фигуру, последовательно отмечая контрольные точки на сторонах колонки, программа автоматически изменяет углы наклона стежков при поворотах колонки.




 SHAPE  \* MERGEFORMAT 



2. Выполнение упражнений с волнистыми линиями
При выполнении данного упражнения мы изучим основные возможности по изменению формы рисунка.
      Выполните щелчок левой кнопкой мыши по пиктограмме New (Новый) для создания  нового изображения.
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	1. Выполните щелчок левой кнопкой мыши по пиктограмме Resequence (Упорядочение), если таблица автофигур не отображается.
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	2. Выполните щелчок левой кнопкой мыши по пиктограмме Parallel Fill (Параллельный застил). Начните с самой верхней левой точки, затем отметьте правой кнопкой мыши все крайние точки волн.

	
	3. Выполните щелчок левой кнопкой мыши по двум углам, в конечной и исходной точке, чтобы закрыть фигуру, нажмите  Enter.

	
	

	
	


Как вы видите, изгиб волны зависит от расстояния между точками.
                  Если вы хотите изменить точки, выполните щелчок левой    [image: image37.png]


     кнопкой мыши по пиктограмме Reshape (Изменить фигуру).
· Вы можете изменить форму объекта. Для этого необходимо отметить его инструментом Reshape (Изменить фигуру) и переместить, добавить или удалить контрольные точки от углов к кривым.

 SHAPE  \* MERGEFORMAT 



· Выполните щелчок левой кнопкой мыши по отдельной точке и перетащите ее в новое положение.

· Для завершения нажмите на кнопку Esc.
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 SHAPE  \* MERGEFORMAT 
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Изменение изображения путем:
· добавления
· удаления
· изменения
· перемещения контрольных точек
в зависимости от типа объекта и требуемого изменения.
Перемещение точек:

· Откорректируйте положение контрольной точки, перетащив ее по контуру туда, куда нужно.
[image: image42.jpg]



Добавление точек:

· Выполните щелчок левой кнопкой мыши для добавления точки в угол.
· Выполните двойной щелчок правой кнопкой мыши для добавления точки на кривой линии.
[image: image43.jpg]



Удаление точек:

· Выделите контрольную точку.
· Нажмите на клавишу Delete (Удалить).
[image: image44.jpg]






3. Выполнение упражнений с круглыми фигурами
При выполнении данного упражнения мы изучим основные возможности вставки рельефных фигур и изменения цветов.
Выполните щелчок левой кнопкой мыши по пиктограмме New (Новый) для создания  нового изображения.
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	1. Выполните щелчок левой кнопкой мыши по пиктограмме Resequence (Упорядочение), если таблица автофигур не отображается.

	
	2. Выполните щелчок левой кнопкой мыши по пиктограмме Parallel Weave Fill: Circle (Параллельный застил: Круг). Начните с круга слева. Нажмите на левую клавишу в начальной точке и отведите курсор на необходимый радиус. Затем вставьте все остальные круги.
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	3. Можете щёлкнуть левой кнопкой мыши по пиктограмме Visualizer (Режим отображения), чтобы посмотреть результат.
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	4. Выполните щелчок левой кнопкой мыши по каждому кругу отдельно, затем щелкните правой кнопкой мыши. Выберите команду Object Details (Формат объекта).

	
	5. Stitch Type (Тип строчки):
Embossed Fill (Рельеф)
Pattern (Узор): например, Triangle 2 (Треугольник 2)
Установите разные опции для  кругов.

	
	

	
	6. Измените цвет каждого круга.
Если палитра цветов не отображается: 
щёлкните левой кнопкой мыши по пиктограмме     [image: image48.png]



· Выполните щелчок левой кнопкой мыши по кругу.
· Выполните щелчок левой кнопкой мыши по цвету в палитре цветов.

· Проделайте то же самое для каждого круга.
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	7. Выполните щелчок левой кнопкой мыши по пиктограмме Visualizer (Режим отображения), чтобы просмотреть окончательные результаты.
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Таблица цветов
[image: image52.png]
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4. Выполнение упражнений с эмблемами
При выполнении данного упражнения мы будем изменять форму фигуры инструментами Reshape (Изменить фигуру), использовать инструмент Border (Границы), научимся центрировать и масштабировать фигуры.
	
	1. Выполните щелчок левой кнопкой мыши по пиктограмме New (Новый) для создания  нового изображения.
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	2. Выполните щелчок левой кнопкой мыши по строке Hoop (Пяльцы) и выберите подходящие размеры.

	
	3. Выполните щелчок левой кнопкой мыши по Parallel Weave Fill: Rectangle (Параллельный застил: Прямоугольник) Нарисуйте прямоугольник: нажав на левую клавишу и перетаскивая её - 8 см по горизонтали и 6 см по вертикали.

	
	4. Выполните щелчок правой кнопкой мыши по прямоугольнику.
Выполните щелчок левой кнопкой мыши по строке Object Details (Формат объекта) контекстного меню.
Выполните щелчок левой кнопкой мыши по опции Dimensions, position (Размеры, положение)
X: введите 0

Y: введите 0
прямоугольник будет отцентрован.
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	5. Измените форму прямоугольника так, чтобы он был похож на эмблему, для этого:

	
	

	
	выполните щелчок левой кнопкой мыши по пиктограмме Reshape (Изменить фигуру).
Выполните щелчок левой кнопкой мыши по точке в центре нижней линии и перетащите ее на 3 см.

	
	6. Выполните щелчок правой кнопкой мыши по точкам в центре линий и перетащите их на 1 см, как показано на рисунках:
· влево-вниз
· вправо-вниз
· вниз.

	
	7. У вас получится что-то вроде этого.
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	8. В таблице цветов выберите белый цвет.

	
	9. Крест
Выполните щелчок левой кнопкой мыши по пиктограмме Parallel Weave Fill (Параллельный застил). 

 Нажимая на клавишу Ctrl, нарисуйте возле эмблемы крест по 2 см  каждая сторона. Подтвердите клавишей Enter.

	
	10. Нажмите на правую клавишу мыши, вызвав контекстное меню, отцентрируйте эмблему и крест, последовательно, выбрав из меню  Object Details (Формат объекта) и задав положение (0;0).
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	11. Границы креста 
В таблице цветов выберите красный цвет.

Для обрамления креста выполните щелчок левой кнопкой мыши по пиктограмме Border (Обвод контура бордюром) и, нажимая на клавишу Ctrl, обойдите крест по контуру. Подтвердите клавишей Enter.
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	12. Изменение угла границы.
Выполните щелчок левой кнопкой мыши по пиктограмме Reshape (Изменить фигуру).

Для изменения  границ поместите вдоль контура квадратики – правой клавишей и кружки – левой клавишей. Перетаскивая их по своему усмотрению, корректируйте форму образца.
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5. УПРАЖНЕНИЯ С ВВОДОМ ТЕКСТА
В данном упражнении мы рассмотрим использование некоторых функций по работе с текстом.
	
	13. Нажмите на New document (Новый документ).
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	14. Выполните щелчок левой кнопкой мыши по строке Hoop (Пяльцы) и выберите подходящие размеры.
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	15. Выполните щелчок левой кнопкой мыши по пиктограмме Resequence (Упорядочение), если таблица автофигур не отображается.
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	16. Выполните щелчок левой кнопкой мыши по пиктограмме Lettering (Текст).
Введите текст:
«Digitizer Ex»
Выберите шрифт:
Honeypot

размер шрифта:
15,

направление:
free line (горизонтально),

Нажмите на кнопку OK.
Выполните щелчок левой кнопкой мыши на экране, чтобы указать точку начала.
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	17. Выполните щелчок левой кнопкой мыши по пиктограмме Lettering (Текст).

Введите текст:
«Create»

Выберите шрифт:
Olivia
размер шрифта:
15,

направление:
free line vertical (вертикально),

Нажмите на кнопку OK.

Выполните щелчок левой кнопкой мыши на экране, чтобы указать точку начала.
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	18. Выполните щелчок левой кнопкой мыши по пиктограмме Lettering (Текст).

Введите текст:
«what you are dreaming»

Выберите шрифт:
Sprite
размер шрифта:
15,

направление:
circle cw (по окружности),

Нажмите на кнопку OK.

Marl the center of the circle on-screen. Mark a point on the circumference to define the radius. Press Enter for a perfect circle.
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	19. Щелчком по пиктограмме Visualizer (Режим отображения) перейдите в режим объемного отображения.
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[image: image76.png]€lna Digitizer €x

e so—=CY
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	20. Выполните щелчок левой кнопкой мыши по пиктограмме Reshape (Изменить фигуру) и перетащите треугольник (в круге с черной границей, см. рисунок ниже) вверх по кривой линии.
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В результате, получается следующее. Щелчком по пиктограмме Visualizer (Режим отображения) перейдите в режим объемного отображения.
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6. АВТОМАТИЧЕСКОЕ  ФОРМАТИ-РОВАНИЕ ЦИФРОВОГО РИСУНКА  

Автоматическое форматирование, т.е. перевод изображения (рисунка) из графического формата в формат вышивки, производится командой Click-to-Design Instantly (Щелчком – в дизайн).
	
	1. Выполните щелчок левой кнопкой мыши по пиктограмме New (Новый).

	
	2. Откройте какую-либо картинку в цифровом графическом формате, например Кораблик (SAILS.BMP): Image>Insert Image>Embroidery Album>sails.bmp.

	
	3. С помощью команды Save as (Сохранить как) сохраните рисунок под другим именем.
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	4. Выполните щелчок левой кнопкой мыши по пиктограмме Resequence (Упорядочение), если таблица автофигур не отображается.
5. Выполните щелчок левой кнопкой мыши по рисунку.
6. Выполните щелчок левой кнопкой мыши по пиктограмме Click-to-Design Instantly (Щелчком – в дизайн) – изображение переформати-руется в формат вышивки. При сохранении можно выбрать один из вышеперечисленных вышивальных форматов.
7. Полученный дизайн вышивки можно редактировать: менять цвет парусов, неба и т.п. (выполните щелчок левой кнопкой мыши по  фрагменту данного цвета, затем по новому цвету в таблице цветов), форму, размеры и место расположения.

	

	
	
	

	
	
	

	
	
	





7. ПРИЛОЖЕНИЯ
Клавишные комбинации быстрого вызова
	Чтобы
	Нажать

	Создать новый рисунок (только EasyDesign)
	[image: image85.png]




	Открыть существующий рисунок
	[image: image86.png](Cir) + (O





	Сохранить рисунок
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	Распечатать рисунок
	[image: image88.png](Gn) + (F)





	Выйти из приложения
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	Открыть таблицу цветов
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	Чтобы
	Нажать или щелкнуть

	Select tool (Выбрать инструмент)
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	Выбрать несколько объектов
	[image: image92.png]Ctr) + (9





	Выбрать область
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	Первый и последний объекты


	Чтобы
	Нажать

	Сделать копию объекта
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	Удалить выбранный или последний объект
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	Чтобы
	Нажать или щелкнуть

	Изменить форму объекта (только EasyDesign)
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	Подталкивание выбранного объекта
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	Чтобы
	Нажать
	Или

	Подогнать пяльцы по ширине окна
	[image: image98.png]



	

	Подогнать рисунок по ширине окна
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 (ноль)
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	Увеличить отображение рисунка
	[image: image101.png]]




	

	Уменьшить отображение рисунка
	[image: image102.png]



	

	Увеличить отображение участка
	[image: image103.png]



	

	Отцентровать текущий стежок
	[image: image104.png]
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	Вернуться к предыдущему виду
	[image: image106.png]
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	Чтобы
	Нажать

	Удалить последнюю контрольную точку (только EasyDesign)
	[image: image108.png](«+—Bhksp)





	Включить/выключить подложку
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	Отобразить окно формата шрифта (только EasyDesign)
	[image: image110.png]


































	Чтобы
	Нажать или щелкнуть

	Выделить следующий объект
	[image: image111.png]




	Выделить предыдущий объект
	[image: image112.jpg]St + (Tab™s)





	Добавить следующий объект к выделению
	[image: image113.png]




	Добавить предыдущий объект к выделению
	[image: image114.png]




	Выделить все объекты
	[image: image115.png]Ctrl) + (2]





	Отменить выделение всех объектов
	[image: image116.png]


 или [image: image117.png]




	Сгруппировать выделенные объекты
	[image: image118.png]




	Разгруппировать выделенные объекты
	[image: image119.png](Cidl +(U)






	Чтобы
	Нажать

	Вырезать объект
	[image: image120.png]() + (X]





	Копировать объект
	[image: image121.png]




	Вставить объект
	[image: image122.png]





	Чтобы
	Нажать

	Показать/скрыть рисунки (только EasyDesign)
	[image: image123.png]




	Показать/скрыть соединители
	[image: image124.png]




	Показать/скрыть таблицу цветов
	[image: image125.png]




	Измерить расстояние на экране
	[image: image126.png]




	Обновить экран
	[image: image127.png]


 или [image: image128.png](f4)





	Меленная перерисовка
	[image: image129.png]8






	Перемещение
	Клавиа​тура ↑
	Клав. панель ↕

	В начало рисунка
	[image: image130.png]



	[image: image131.png]




	В конец рисунка
	[image: image132.png][End)




	[image: image133.png]




	К следующему цвету (только EasyDesign)
	[image: image134.png]



	[image: image135.png]




	К предыдущему цвету (только EasyDesign)
	[image: image136.png]



	[image: image137.png]




	На 100 стежков вперед (только EasyDesign)
	
	[image: image138.png]




	На 100 стежков назад (только EasyDesign)
	
	[image: image139.png]




	На 10 стежков вперед (только EasyDesign)
	[image: image140.bmp]
	[image: image141.png]




	На 10 стежков назад (только EasyDesign)
	[image: image142.bmp]
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	На 1 стежок вперед (только EasyDesign)
	[image: image144.png]
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	На 1 стежок назад (только EasyDesign)
	[image: image146.png]=)
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	↑ Сначала нажать на Esc ↕ Выкл. Num Lock


Панель инструментов Easy Design 

                                                  (Лёгкий дизайн)
	Инстру​мент
	Описание
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	Parallel Fill  - Параллельный застил различных фигур

	[image: image149.jpg]<%




	 Turning Angle Fill – Угловой застил - создание колонок различной ши​рины и угла строчки. 

	[image: image150.jpg]=t




	Parallel Fill : Rectangle l - Па​раллельный застил: Прямоугольник – вставка прямоугольных фигур с параллельным застилом.

	[image: image151.jpg]@




	Parallel Fill : Circle - Парал​лельный застил: Круг – вставка круглых фигур с параллельным застилом. 

	[image: image152.jpg]



	Single Run Line (Контурная линия) - строчки одинарным или тройным стежком по нанесенной линии. 

	[image: image153.jpg]



	Border (Обвод контура бордюром) для соз​дания колонок или границ фиксированной ширины. 

	[image: image154.jpg]



	Appliqué (Аппликация) для вставки аппликаций. 

	[image: image155.jpg]



	Щелкните по пиктограмме Current Colour (Текущий цвет) для открытия палитры цветов. Используйте ее для изменения цветов выбранных объектов или установки цвета по умолчанию для новых объектов. 

	[image: image156.jpg]



	Используйте инструмент Embroidery Gallery (Гале​рея вышивки) для вставки образцов (моделей) в рисунки. 

	[image: image157.jpg]



	Используйте инструмент Image Preparation (Подго​товка рисунка) для уменьшения количества цветов и удаления пятен с неоконтуренных фрагментов. 

	[image: image158.jpg]



	Используйте инструмент Outlined Image Preparation (Подготовка оконтуренного рисунка) для уменьше​ния количества цветов и удаления пятен с оконту​ренных рисунков. 

	[image: image159.jpg]



	Click-to-Parallel Weave Fill (Параллельное заполнение щелчком волнообраз​ной фигуры) для вставки больших фигур с сохране​нием отверстий. 

	[image: image160.jpg]



	Click-to-Parallel Weave Fill without Holes (Параллельное заполнение щелчком волнообразной фигуры без отверстий) для вставки больших фигур без сохранения отверстий

	[image: image161.jpg]€,




	Click-to-Turning Angle Fill (Угловое заполнение щелчком) для вставки узких фигур челночным стежком для вышивания гладью. 

	[image: image162.jpg]i g/)




	Click-to-Centerline (Вставка щелчком центральных линий) для вставки в рису​нок вышивки линий центровки строчки. 

	[image: image163.jpg]



	Click-to-Outline (Вставка щелчком границ) для вставки границ строчкой с те​кущими свойствами. 

	[image: image164.jpg]



	Match to Palette (Найти со​ответствие палитры) для поиска цвета нитки, наи​более соответствующего цвету выбранного изо​бражения. Если выделение отсутствует, использу​ется текущий цвет палитры.

	[image: image165.jpg]g’?




	Click-to-Design Instantly -  Автоматическое форматирование рисунка -  создание рисунков вышивки из импортированных изображе​ний с использованием установок по умолчанию. 

	[image: image166.png]



	Инструмент Click-to-Design Advanced  - Расширенное форматирование рисунков для большего контроля создания рисунков вышивки из импорти​рованных изображений. 

	[image: image167.png]d{




	Используйте инструмент Photo Click Instantly - Авто​матическое форматирование фотографий для создания рисунков вышивки из фотографий. 

	[image: image168.png]



	Используйте инструмент Photo Click Advanced (Расширенное форматирование рисунков из фотографий) для большего контроля создания рисунков вышивки из фотографий или изображений. 


Панель инструментов Easy Edit 
                                           (Лёгкое редактирование)
	Инстру​мент
	Описание

	[image: image169.png]



	Щелкните по пиктограмме Select (Выбрать), а затем по объекту. Другой вариант: растащите ограничивающее окошко вокруг объекта.

	[image: image170.png]



	Щелкните по пиктограмме Polygon Select (Выбор многоугольником) для выбора объектов ограничивающим окошком. Отметку участка производите так же, как и выбор объекта.

	[image: image171.png]



	Используйте инструмент Object Details (Формат объекта) для задания установок выбранных объектов или текущего рисунка в целом. Только EasyDesign.

	[image: image172.png]



	Щелкните по пиктограмме Reshape (Изменить фигуру) для отображения контрольных точек и угла строчки в выбранных объектах. Только EasyDesign.

	[image: image173.png]



	Щелкните по пиктограмме Flip Along Horizontal (Повернуть по горизонтали) для поворота выбранного объекта или рисунка по горизонтали.

	[image: image174.png]



	Щелкните по пиктограмме Flip Along Vertical (Повернуть по вертикали) для поворота выбранного объекта или рисунка по вертикали.

	[image: image175.png]



	Щелкните по пиктограмме Rotate CCW/CW (Повернуть против часовой стрелки/по часовой стрелке) на панели редактирования для поворота выбранного объекта или рисунка на 45° по часовой стрелке. Щелчком по правой клавише выполняется поворот на 45° против часовой стрелки

	[image: image176.png]



	Щелкните по пиктограмме Feather Edge (Сглаживание краев) для применения эффекта сглаживания к выбранным объектам. Только EasyDesign.

	[image: image177.png]



	Используйте инструмент Underlay (Подложка) для автоматического применения подложки к новым или выбранным объектам.

	[image: image178.png]



	Используйте инструмент Cut Hole (Вырезать отверстие)  для вырезания участков в выбранных объектах. Нельзя вырезать отверстие в круглых объектах или объектах, вставленных под углом. Только EasyDesign.

	[image: image179.png]14




	Используйте инструмент Resequence (Упорядочение) для упорядочивания выбранных объектов по типу или цвету. Только EasyDesign.

	[image: image180.png]



	Используйте инструмент Stitch Mode (Режим строчки) для выбора отдельных стежков для редактирования. Только EasyEdit.

	[image: image181.png]i




	Используйте инструмент Split Block (Разбить блок) для разделения рисунка в выбранной точке. Только EasyEdlt.


Стандартные шрифты
	НАЗВАНИЕ ШРИФТА
	ПРИМЕР
	НАЗВАНИЕ ШРИФТА
	ПРИМЕР
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	НАЗВАНИЕ ШРИФТА
	ПРИМЕР
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Галерея вышивки, примеры рисунков и узоров
	ИМЯ
	ПРИМЕР
	ИМЯ
	ПРИМЕР
	ИМЯ
	ПРИМЕР
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Примеры рельефного фона
	ИМЯ
	РЕЛЬЕФ
	ИМЯ
	РЕЛЬЕФ
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Примеры волнообразного фона
	ИМЯ
	РЕЛЬЕФ
	ИМЯ
	РЕЛЬЕФ


[image: image192.jpg]X 2 2 = 2 2 & ~ & N & &
iy
- ~ ) «+ n © ~ © o 2 = el i





Сделали ошибку?


Нажмите на клавишу Backspace для удаления последней введенной точки и продолжите работу.





Идеальный круг:


Чтобы получился идеальный круг, достаточно отметить правой кнопкой мыши три точки.





Точка выхода





Точка изгиба





Точка изгиба





Точка входа





Чтобы получить строго прямую линию, нажмите на клавишу Ctrl и щелкните левой кнопкой мыши.





Чтобы изменить форму объекта, щелкните левой кнопкой мыши по пиктограмме Reshape (Изменить фигуру).


�





Увеличить:


Нажмите на клавишу B, выполните щелчок левой кнопкой мыши и выделите участок увеличения.





Увеличить:


Нажмите на клавишу Z


Уменьшить:


Нажмите на Shift+Z


или


Нажмите на 1.
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